Frequently Asked Questions about
Analytics Lab for Morningstar Direct

This document offers answers to the following questions about using Analytics Lab Overview
for Morningstar Direct:

» The Benefits of Using Analytics Lab (page 2)

» Technical Details for Using Analytics Lab (page 4)
» Exploring the Data in Analytics Lab (page 6)

» Client Service with Analytics Lab (page 8)
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The Benefits of Using Analytics Lab Overview

The Benefits of Using Analytics Lab

This section covers the following questions related to the benefits of using Overview
Analytics Lab as a platform:

» How can Analytics Lab help me scale my data analysis and research? on page 2

» Why not use Microsoft® Excel® to do this work, instead of Analytics Lab? on page 2,
and

» How will Data Scientists, Quantitative Analysts, and Quantitative Researchers use
Analytics Lab? on page 3

Analytics Lab provides a hosted, scalable Python development environment with How can Analytics Lab
seamless access to Morningstar data. The platform allows you to leverage Morningstar help me scale my data
data and your knowledge of Python to automate investment analysis using the popular ~ analysis and research?
open-source tool, Jupyter Notebooks. Using Analytics Lab, you can quickly mine large

data sets, and build predictive models (or other advanced analytics) to drive

efficiencies, mitigate risk, and ultimately improve your investment decision making.

Microsoft® Excel® is a pervasive tool within an enterprise, but trying to use Why not use Microsoft®
spreadsheets for advanced, responsive analytics over a large volume of data is using Excel® to do this work,
the wrong tool for the job. Power Microsoft® Excel® clients face the following problems:  instead of Analytics Lab?

» Errors propagate easily

» Limited scalability

» Slow calculation performance

» Barriers to testing the correctness of a spreadsheet

» Cumbersome debugging, and

» Constrained collaboration making version control challenging.

While spreadsheets are helpful for small and quick-fix calculations, when they turn into
permanent enterprise-grade solutions, the integrity of financial, operational, and
regulatory processes can be threatened. In addition, in many cases the volume of data
involved in these analysis simply cannot be handled efficiently in Microsoft® Excel®.
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How will Data Scientists, Quantitative Analysts, and Quantitative

The Benefits of Using Analytics Lab Researchers use Analytics Lab?
Within the Asset Management and Wealth Management industries, applying How will Data Scientists,
advanced analytics to specific business problems now offers value compared Quantitative Analysts,

to the recent past, by increasing the ability to sift through vast amounts of data to and Quantitative

draw insights and identify trends. A broad set of firms are embracing new analytics Researchers use

methods at multiple points across the asset-management value chain—from Analytics Lab?

increased sophistication in distribution of research and analytics, to driving
efficiencies in middle-and back-office productivity.

Teams doing this work, however, often face challenges. Gaining access to the right
data sets and provisioning an appropriate amount of computing resources to process
large amounts of data can be time consuming and costly. This prevents quick
experimentation and can delay responses to market events or regulations.

Analytics Lab solves these problems by allowing data science and quantitative
research teams to easily access Morningstar data in an environment with scalable
infrastructure. This means experimentation is easy and answering timely questions
related to market events isn't held up by data integration or infrastructure issues.
Further, through the use of Jupyter Notebooks, the outcome of an analysis can be
easily communicated through embedded visuals and commentary — facilitating a more
efficient pathway from analysis to decision making.
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Technical Details for Using Analytics Lab Overview

Technical Details for Using Analytics Lab

This section covers the following questions related to the technical details Overview
of using Analytics Lab:

» What browsers are supported for Analytics Lab? on page 4

» What python and charting packages are available in Analytics Lab? on page 4

» Where can | find documentation for the Morningstar Data python package? on
page b

» Can | download the morningstar_data Python package to my local machine? on
page b

» Do you support MATLAB/QOctave? on page 5

» Is R supported with Analytics Lab? on page 5, and

» Can | view the code for Interactive Research notebooks available in Morningstar
Direct? on page 5.

The latest versions of the following browsers are all supported: What browsers
are supported
: Ei?é?(;?(e for Analytics Lab?
» Safari, and
» Edge.

< Note: Internet Explorer and Edge versions 78 and below are not supported.

You can see the list of installed and available packages in the What python and
morningstar-AnalyticsLab kernel by opening a notebook and using the pip list charting packages
command. You also can create your own kernel and install additional Python are available

and charting packages by using the Conda Store Package Manager. in Analytics Lab?

Use the pip list command in a notebook
to see the full list of available packages.

& Laugcher X | A untitleds.ipynb L]

B4 XD O » = ¢ » Code ~ i Schedule Notebook = (@ #  Python [morningstar-analyticslab] O

Get Started Building Custom Analytics

The morningstar_data Python package provides access to Morningstar data.

You can find documentation about the package in the Morningstar Data Python Reference

import morningstar_data as md

pip list

Package Versio
aiobotocore 2.1.8
aichttp 3.8.6
aicitertools @.11.0
aiosignal 1.3.1
altair 4.2.2
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Where can | find documentation for the Morningstar Data

Technical Details for Using Analytics Lab

python package?

On the toolbar, select Help > Morningstar Data Python Reference.

Documentation for the python package is found here.

Where can | find
documentation for
the Morningstar Data
python package?

Il amaticsiso File  Ecit View Run  Kemel Git Tabs Settings| Help I;‘na'ﬂics_ab

T euncher X | [A UntitledS.ipynb | Aboutlupyterlab
B+ XDO0O» m ¢ » Coe v @Sc Licenses

o Show Contextual Help Ctrl+l
Get StartEd Bl‘“Idlng Custom Launch Classic Notebook

0 : Morningstar Data Python Reference
The morningstar_data Python pj - :

= Training
You can find documentation about the package in Ea

8 import morningstar_data as md Jupyter Forum

Y pip list Jupyter Reference

\lﬁ

JupyterLab FAQ

Jupyterlab Reference

&%  Python [momingstar-analyticslab] O

Yes, you can! For installation instructions, please visit:
https://pypi.org/project/morningstar-data/

< Note: Even if used externally, the package is subject to the same
data limitations as Analytics Lab.

Not at this time. If that is something you are interested in, please see How can | send
feedback about Analytics Lab? on page 8.

An R kernel is available within Analytics Lab. However, the library to access
Morningstar data and Direct user objects is available only as a Python package.

The Interactive Research currently available in Morningstar Direct will be released
gradually into the Analytics Lab platform as tutorial notebooks in late April 2024.
Use these notebooks to better understand the methodology behind our analysis
and as a starting point for your own analysis.

Can | download the
morningstar_data Python
package to my local
machine?

Do you support
MATLAB/Octave?

Is R supported
with Analytics Lab?

Can | view the code

for Interactive Research
notebooks available in
Morningstar Direct?
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Exploring the Data in Analytics Lab

Overview

Exploring the Data in Analytics Lab

This section covers the following questions about the data points clients will find
in Analytics Lab:

» What data is available in Analytics Lab? on page 6

» Are model portfolios and custom benchmarks available in Analytics Lab? on page 6

» How fast can | expect data to return in Analytics Lab? on page 6

» How many layers of holdings are available for fund-of-funds in Analytics Lab? on
page 6

» What is the best way to find a specific data point in Analytics Lab on page 7, and

» Why can't | view ISINs or CUSIPs in Analytics Lab? on page 7.

Any investment data you can retrieve from Morningstar Direct is available in Analytics
Lab. You can even use investment lists and data sets you've created in Morningstar
Direct by referencing them in a notebook. For instructions on how to do that, see the
tutorial notebook on the launcher page.

Custom portfolio data is available in the Morningstar Data Python Package. For more
details, please refer to Help > Morningstar Data Python Reference.

You can expect data retrieval in Analytics Lab to match about the same speed as
it would take to open the full, equivalent data set in the Workspace module of
Morningstar Direct. Naturally, larger data sets will take longer to load.

Note that larger data sets (such as those for asset flows with many time periods
for a market) and large performance reports will take longer to load.

The analyticslab.direct.get_holdings service can be used to retrieve single-level
holdings for funds-of-funds. Drilling down further is not currently available. If this is
something you are interested in, please see How can | send feedback about Analytics
Lab? on page 8.

Overview

What data is available
in Analytics Lab?

Are model portfolios
and custom
benchmarks available
in Analytics Lab?

How fast can |
expect data to return
in Analytics Lab?

How many layers of
holdings are available
for fund-of-funds

in Analytics Lab?
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Exploring the Data in Analytics Lab What is the best way to find a specific data point in Analytics Lab

The Morningstar Direct Extension was recently added to Analytics Lab, this tool What is the best way
supports users in easily searching, browsing, and filtering data points by universe to find a specific data
and data set. point in Analytics Lab

Il anatics st fprevient File  Edit  View Run  Kemel Tabs Settings Help  Analytics Lab

Filter files by name Q
o Click thisicon
-/ to easily be able to
find dat_a points
— | Name - Last Modified from existing
== data views in
B chared - Mailinator a day ago Morningstar Direct.
T Frrteteis A
il .
B Untitled Folder a month ago

@ Untitled Folder 1 a month ago Analytics I.ab

If you are not fully licensed to export ISIN codes and CUSIPs, then you cannot access Why can't | view ISINs or
this data in Analytics Lab. To register your license, in Morningstar Direct, go to the CUSIPs in Analytics Lab?
Content Catalog page under the Home module and select the References tab. Your

Customer Success Manager (CSM) can also help with this request.

Select this tab to adjust the settings
for access to CUSIPs and ISIN codes.

(] Maorningstar Direct

File Mew Favorites Tools Help \ Search for ‘In Securities * Go
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E Excel Add-In
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E Morningstar Publications s . 5 e a
B HFR R h If you require content not listed in the Content Catalog, please contact your firm’s procurement or market data team to submit the request
esearcl

& Content Catalog to your firm's content vendor account manager to deliver the specific content to Morningstar, Inc.
} & Learning Center

To request access to References, please drag each red circle to the right. Additional inquires may be directed towards the Vendor Contact.

Although additional fees may apply, no charge will be issued or access granted without a prior discussion with the appropriate Vendor.
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Client Service with Analytics Lab

Overview

Client Service with Analytics Lab

This section covers the following questions related to client service concerns
with Analytics Lab:

» Do you have example notebooks | can use as a starting point? on page 8
» How can | send feedback about Analytics Lab? on page 8, and
» Where do | go for questions not answered in this document? on page 8.

See the Tutorials section on the launcher to view an example notebook explaining
how to retrieve data.

Double-click this item to see an example
notebook explaining how to retrieve data.

Overview

Do you have example
notebooks | can use
as a starting point?

Il snsiysics Lsb et File  Edit  View | Run  Kernel Git Tabs

Settings Help  Analytics Lab

[Z Launcher

m/

Mame - Last Modified

¢ O &

B Morningstar Motebooks 8 days ago
B shared - Momingstar

| B Tutorials

4 minutes ago

6 days ago
M Untitled.ipynb 9 days ago
IITII A Untitled1.ipynb 9 days ago

Morningstar plans to expand the Tutorials section in the future, so if you have an idea
for something valuable to add here, please see How can | send feedback about
Analytics Lab? on page 8.

To send feedback about Analytics Lab, please contact your Customer Success
Manager (CSM).

Please contact your CSM.

How can | send feedback
about Analytics Lab?

Where do | go for
questions not answered
in this document?
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